Cascade V8.17.1
Web Content Management Guide
University of Missouri—St. Louis
Contents
What is Cascade? .......................................................................................................................................... 4
Getting Started: Creating an Account, Training and Logging In.......................................................... 4
  Cascade Login ........................................................................................................................................... 4
  Recommendations ................................................................................................................................. 4
Dashboard ..................................................................................................................................................... 5
  Widgets .................................................................................................................................................... 5
  Customizing Your Dashboard ................................................................................................................ 6
Assets and Structure ..................................................................................................................................... 8
  Assets ....................................................................................................................................................... 8
Folders ........................................................................................................................................................... 9
  Creating a folder ................................................................................................................................... 10
Pages ........................................................................................................................................................... 11
  Adding a New Page .............................................................................................................................. 12
  Editing an Existing Page ....................................................................................................................... 13
Page Content ............................................................................................................................................... 14
  Begin Building Page Body Content ..................................................................................................... 16
  Columns ................................................................................................................................................ 16
  Content Card ....................................................................................................................................... 18
  Accordion ............................................................................................................................................ 21
  Image Gallery ...................................................................................................................................... 22
  Slideshow ............................................................................................................................................ 23
  Tabs ..................................................................................................................................................... 24
  Right Content Area .............................................................................................................................. 25
Blocks .......................................................................................................................................................... 26
  Adding or changing a Related Links List Block .................................................................................. 27
  Adding or changing a Right Callout Block ......................................................................................... 27
WYSIWYG (What you see is what you get) Editor ...................................................................................... 28
  Format ................................................................................................................................................. 29
  Insert ................................................................................................................................................... 31
Full Width Content ...................................................................................................................................... 34
Images ........................................................................................................................................................... 35
  Image Size Recommendations ............................................................................................................. 36
What is Cascade?

Cascade is the Content Management System the university uses to create, manage, and publish content to the web. This guide should be referenced to help answer questions regarding features in Cascade. If you do not find what you’re looking for in this guide, please reach out to a member of the UMSL Web team for further assistance.

Getting Started: Creating an Account, Training and Logging In

Contact the Web team to request an account and sign up for training.

New Users must sign up for training to receive a Cascade account. Once granted, users will sign in using their SSO. The Web team will communicate further instructions via email once a new user has registered for training.

Register for Training: [https://www.umsl.edu/marketing/web/cascade-training.html](https://www.umsl.edu/marketing/web/cascade-training.html)
New users will have access to the Training Site only until training is complete.

Cascade Login

[https://umsl.cascadecms.com/](https://umsl.cascadecms.com/)

Troubleshooting

Contact the [UMSL Web team](https://umsl.cascadecms.com/) for any login issues.

Recommendations

- **Bookmark** - We recommend you bookmark the Cascade login page in your browser for easy access.

- **Browser** - Browser functionality changes as Cascade updates are made. The [UMSL Web team recommends using](https://umsl.cascadecms.com/) either Chrome or Firefox on a desktop for full CMS functionality.
Dashboard

The Cascade CMS dashboard is a bird's eye view of your action items, notifications, and site content. The Dashboard consists of multiple widgets which can be added, removed or moved around on the screen as needed. You can add or customize widgets to reflect data from one or more of your sites.

Widgets

By default, the dashboard includes the following widgets:

- **Welcome** - You can add widgets or reset your dashboard from the Welcome widget. If you have unread notifications, you can click the badge on the date in this widget to view them.
- **My Sites** - Sites you've recently visited will be listed here. Click any of them to switch to the site or use the Site dropdown menu at the top right to view all sites you have access to.
- **My Upcoming Tasks** - Tasks assigned to you will be listed here in order of their due date.
- **New Content** - Create new assets right from the dashboard by clicking on any of the Asset Factories in this widget.
- **My Content** - Quickly access your starred and recently viewed assets, owned content, drafts and working copies from this widget.
- **My Workflows** - If you or a Group you're assigned to has waiting workflows, you'll find them here. UMSL does not currently have workflows implemented.
- **Stale Content** - Keep your content fresh by monitoring stale assets that haven't been updated in a while.
- **Notifications** - Your most recent notifications such as workflow notifications, publish reports, and user mentions will be listed here.
- **Content to Review** - Assets with upcoming review dates will be listed here.
- **Link Checker** - If a broken link check is scheduled for your site(s), the number of broken links and assets with broken links found will be displayed here.
Customizing Your Dashboard

If you have a Default Site chosen in your account settings, newly added widgets will be pre-configured to display data and content from that site.

To Customize a Widget

1. Hover over the widget and click the pencil icon in the upper-right corner.

2. Configure your widget and click Save Settings.

To Move or Reorder Widgets on the Dashboard

1. Hover over the widget, click and hold the menu in the upper-left corner.

2. Drag the widget to its new position on the dashboard.

To Add Widgets to Your Dashboard

1. Click the Add Widget button in the Welcome widget.

2. Click the plus sign next to the widget you'd like to add.

3. Note that you can have multiple widgets of the same type on your dashboard configured to reflect data from different sites.

To Remove Widgets from Your Dashboard

1. Hover over the widget and click the X icon in the upper-right corner.

2. Confirm that you'd like to remove the widget from your dashboard.
To Reset Your Dashboard to the Default Widget Configuration

1. Click the Reset Dashboard button in the Welcome widget.
2. If you have a Default Site set in your account settings, all reset widgets will display data from that site.

To Switch into a Site

1. Select a site from the My Sites widget or from the Site menu in the upper-left corner of the top menu bar.
2. Site content will be displayed in the asset tree on the left.
3. The site's Trash bin is located directly above the asset tree.

Once you have selected a site, your dashboard will resemble the following:
Assets and Structure

Assets

An asset is anything you can create, edit and manage in Cascade. “Asset” is a term referring to a file, folder, block, or page in Cascade. You may work with the following assets in Cascade:

1. 📝 Page – indicates a web page.

2. 📄 File – created by an external program and imported for use in Cascade, may be a jpeg image, PDF file, or any other static content.

3. 📦 Block - a "pluggable" piece of content that can be easily substituted, into the right-hand related links area, the image rotation block, or the right callout area.

4. 🔗 External Link - a link to a specific URL that goes to a web page outside of your Cascade site. Used in the Related Links box or the left-hand menu.

5. 📀 Folder - a container that holds other assets. All assets within a folder should be related to each other. For example, an image folder should only contain image files. Folders are used to create sub-navigation for your site or as containers for non-page assets (images, etc.).

Asset Tree

The asset tree (file directory) displays a hierarchical view of the folders and files that make up your site’s content. All files in your site are located on the Cascade server. See next image.
Folders

Folders help keep your site organized by grouping similar items together. The top level (base or root) folder is labeled with the site name and contains the site’s content. The “_internal”, and “files” folders are typical folders on every site. A folder’s name becomes part of the URL when published. **NOTE: do not delete or alter the “_internal” folder.**

There are several subfolders inside the “files” folder. Typically, “blocks”, “external-links”, “images”, and “pdfs.” Your site may have additional subfolders in the “files” folder, but these are the places where you store your sites files such as images and documents.

Clicking on the arrow to the right of the folder name will reveal its contents in the asset tree and in the main view area. When a folder has a file in it named “index”, then the folder’s **Display Name** displays in the web page’s left-hand navigation menu. For example, the index page of the folder called brand in the screenshot above would result in a URL of www.umsl.edu/marketing/brand.
Creating a folder

Select “Add Content” on the top left of the dashboard and Choose “Unit Pages” and then “Unit Folder”.

You will be prompted to fill out the following fields:

**Folder Name** – this is the name of the folder, which will appear in the URL if you store pages in this folder. A folder name cannot include capital letters, spaces or special characters. It is different from the Display Name (see below).

**Placement Folder** – Choose where you would like to store the new folder.

**Title and Display Name** – This is how the folder will appear in the left navigation or in the breadcrumbs.

**Include in Navigation** – Choose whether you would like the folder to appear in the left navigation. The folder is required to have an index page to appear in the left navigation.
Pages

The index page in the root folder of your site is your homepage. A standard template is applied to each page which sets the page layout. You can add/change content on the page and control the display of the left-hand navigation and the right-hand sidebar.

Most html pages on your site should be contained in folders. These folders not only help to organize files on the back end but build the URLs and breadcrumbs* that are used to access your site. If the folder contains an “index” page it can be added to the site’s left navigation and any additional pages in the folder will appear as sub-menu items if marked for inclusion. Please note that file and page organization do not affect the layout of the top navigation if your site has one in use.

In the example below, notice how the folders and pages affect the URL, breadcrumbs, and the left navigation.

The index page in the “cs” (Creative Services) folder allows it to display on the live website as a left navigation item. “index” will be the landing page for the folder, and “work-requests” is a page that appears in the Creative Services folder.”

Note that although the folder is named “cs,” the Display Name dictates how the folder appears in the left navigation and breadcrumbs.

URL:
https://www.umsl.edu/marketing/cs/work-requests.html
*Breadcrumbs*

Depending on your folder structure, the display name of each sequential folder and page will display in a row at the top of your content, underneath the banner photo or title header of the page. This allows users to easily see where they have been, and to navigate backwards.

Adding a New Page

To add a new page, use the Add Content link and select Unit Pages > New Page. The template provides content areas that you can choose from to customize the layout of your content. Each section of the template is explained below. A red star to the right of the name indicates it’s a required field.

**Create and Name the Page and Set Menu Options**

1. Determine which folder the new page save to, and then click on the arrow to the right of the folder to select it. The left-hand navigation menu is based on folder structure.

2. **Click Add Content > Unit Pages > New Page**

3. Name your page and choose where to store it in your file directory:
Page Name *

Must meet the following requirements: Lowercase only, Word spaces replaced with hyphen.

new-page

Placement Folder *

University Marketing and Communications: /

Page Name – This becomes the page name that appears in the URL. Page Name must be all lowercase without spaces. To separate words, use a hyphen instead of an underscore character. If this is the first page in a new folder, it should be named “index” so the folder’s Display name will appear in the left navigation of your page.

Placement Folder – the location in your Cascade file directory for the new page.

Editing an Existing Page

To edit content for an existing page, navigate to that page, select it and the click the Edit option at the top of the screen. Or right-click on the page name and select Edit from the drop-down box.
Page Content

Whether you are editing an existing page or creating a new one, you have many options at your disposal to customize the look of your page. You will see the following options for every page you create or edit.

- **Page Name** – This becomes the page name that appears in the URL. Page Name must be all lowercase without spaces. To separate words, use a hyphen instead of an underscore character. If this is the first page in a new folder, it should be named “index” so the folder’s Display name will appear in the left navigation of your page.

- **Placement Folder** – the location in your Cascade file directory for the new page.

- **Display Name** – set the name that will appear in the left navigation and breadcrumbs.

- **Title** - appears in search results and the browser tab. " | UMSL" will automatically appear after the title.

- **Include in Site Navigation** – when set to “Yes”, the page will appear in the left navigation. Please note this does not affect to top navigation structures.

- **Display Site Navigation** - displays on the left navigation on pages where this is set to “Yes”.

- **Title Header** - displays directly below the page header when set to “Yes”.

- **Image Header** – if set to “Yes”, choose between image only or image with caption. This image should be about 1250px wide and 400px tall.
Note: Every page should have either a Title Header or an Image Header, but not both. If you use the Image header it is strongly recommended to use the image with caption.

Remember:

- Title displays as a tab label of a browser AND is what Google Search will display as the name of the page in search results AND is on the site content map.
- Display Name appears as the Left Navigation text and Breadcrumbs.
- Page Name becomes part of the URL.
- Page Name cannot contain blank spaces, underscores, or other special characters (\~ \$ < > \# \{ } [] \& + . / ; ; + ? @ )
Begin Building Page Body Content

There are many different page elements, or “content types” to begin building your page. You may choose from:

- Content with 1 Column
- Content with 2 Columns
- Content with 3 Columns
- Content Card
- Accordion
- Image Gallery
- Slideshow
- Tabs

Columns

Select from one, two, or three column layout blocks to build page content.

Content with 1 Column

The lines of text span the full width of the page body. If you have a left navigation and right callout section, the content in the column will be displayed in the area between them.

Content with 2 Columns

In a 2 column layout, you can set the width of the columns by selecting “Yes” under “Set Column Widths.” You will have three width options to choose from, 50% - 50% (sets columns to same width), 66% - 34% (Sets left column width larger than right), and 34% - 66% (Sets right column width larger than left)
The examples below display how the different width settings in the two column layout will appear on the page.

### 50% - 50%

<table>
<thead>
<tr>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
</tr>
</thead>
</table>

### 66% - 34%

<table>
<thead>
<tr>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
</tr>
</thead>
</table>

### 34% - 66%

<table>
<thead>
<tr>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
<th>Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.</th>
</tr>
</thead>
</table>

---

### Content with 3 Columns

This option inserts 3 columns and automatically sets the width of each column.

| This content is arranged in 3 columns. **On mobile, the columns will stack vertically.** | Typically, the more columns, the shorter the content. Try not to pack too much information here. | You can also put pictures here, but please use small images no wider than 300px. |
Content Card

The addition to the Content Card in the CMS page template allows site managers to visually highlight key news and information on their pages. Content Cards include the selection of a feature image, color theme, header/subheader text, and links to more information that display your content professionally and consistently in one, two or three column layouts.

Under the "Build Page Body Content" select "Content Card" and choose one, two or three columns.

One Column Content Card

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam.
Two Column Content Cards

![Red Color Class](image1)

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam.

![Green Color Class](image2)

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam.

Three Column Content Cards

![Intercampus Faculty Cabinet](image3)

Information about IFC members, minutes, and mandates.

![Faculty Handbook](image4)

The Faculty Handbook contains a wide variety of useful information for faculty.

![Senate Suggestion Box](image5)

Comments, questions, or suggestions can be sent to the Faculty Senate Office.

Note - For sites with a left navigation, please don’t use the three column layout. Use either a one or two column layout.

Select a color for each card
Select a Feature Image and Image Link

Upload your feature image to the size appropriate for the layout. One column content card images should be at least 1000px wide while two and three column images should be 500px (width) x 300px (height). Please do not use images files with text in them as they may not display correctly and do not make for a good user experience. In addition screen reading technology will not read the words on an image.

Create an external link first if you're linking the image to a page not housed within your site.

Add Header and Content text, choose if you want Text Link

Add a header title. Note the display size is limited based on the column display selected. Add content and select whether you'd like to include text below the content area that is linked to a URL.

Create an external link first if you are linking to a page not housed within your site.
Accordion

Accordion content allows users to expand and collapse content with just a click. This enhances the user experience, and is especially helpful for displaying complex information that you wish to simplify for site visitors. Particularly on mobile devices, accordions are a more efficient use of space, and make for easier-to-access content. You may add pictures and other elements to the accordions. Please note that content folded into accordions will not be accessible to search engines, although the titles of the accordions will.

An accordion can house more detailed information such as course curriculums, biographical information, schedules and more.
Image Gallery

The Image Gallery option allows you to upload one or more images to display on a page as thumbnails with captions. End users can click on the image thumbnail and a full-size image opens in the browser window. Choose the same image for both "Full Size Image" and "Thumbnail Image". You do not need two sizes of the same photo. Please ensure that your photos are 500kb or less in size or reach out to the Web team for assistance.

Caption is optional, keep brief

If using captions, keep consistent
Slideshow

You may add anywhere from 2 - 11 slides to give your page a dynamic and visually striking element. We strongly recommend keeping the Headline and Descriptive Text short.

Slideshow images should be sized to a consistent height and width before uploading them, otherwise the text and images jump around on the page as content rotates. Please use pictures with a landscape orientation. Typically, images in a slideshow are around 800px width by 450px height.

Set an External or Internal Link and include custom Link Text to give a call to action to your site visitors. An external link, if needed, will need to be created first.

Link text will appear as a red button below the header and caption.
Tabs

Tabs are an optional way to display multiple topics of content on one page, with each topic listed under a separate tab. Name the Tab with a **Header** then in the **Content** area add the content that will appear when that tab is selected. Much like accordions, images and other content may be used here.

Tabs on the live site:

```html
<h1>University Marketing and Communications »</h1>

Tab 1  Tab 2  Tab 3

This is the content for tab 1.
```
Right Content Area

This content displays on the right-hand side of your page if you select “Yes” for the “Display Right Callout/Related Links Navigation” option in the Right Content Area section of the template.

Use this section to add content, keeping in mind that the right callout is a much narrower section than body content. Accordingly, keep things brief in this section. If you want a consistent right hand section across multiple pages, use either a Related Links List Block, or a Right Callout Block.

On the live site, the right callout section is restricted to a narrow column furthest right of the page.
Related Links List Block and Right Callout Block

A “Related Links” list must first be built as a block file. Then you refer to the block file in this section of the template. The block file can be used on multiple pages by just selecting the file for your Related Links on each page you want the content to appear. If you need assistance with a block, please contact the Web team.

Blocks

Blocks enable you to repeat content on your website.

There are two types of blocks, “Related Links List” and “Right Column Callout”. (There is also a Top Navigation block, which your site will have if it utilizes the top navigation feature. Please contact the Web team if you’d like to add a top navigation.)

A Related Links List block is generally a list of important links you’d like to highlight on some or all of the pages on your site. The Right Column Callout block allows you to make consistent content that may or may not include links. You can also use images in the Right Column Callout block. Please note that both blocks will display in the right hand column of your site and are thus narrower in width.

XHTML/Data Definition Block Name *

Must meet the following requirements: Lowercase only.

untitled-related-links-list

Placement Folder +

blocks

University Marketing and Communications: /...

Related Links

Related Page

Add

Choose Page

Related External Link

Add

Choose Link

Add

Choose Link

Add
Adding or changing a Related Links List Block

If you want to use a Related Links list on a page or pages of your site, you will need to create a block file and point to the file in the Right-Side Content > Related Links section on the page(s). A Related Links Block can contain html pages (Related Page) and External Links (Related External Link). Your site may already have a related links list block file, which is typically found in the “blocks” subfolder of the “files” folder. Related Pages will display first in the Related Links box, followed by Related External Links.

1. Select Add Content > Blocks > Related Links List.

2. On the block template page enter a XHTML/Data Definition Block Name. The default name is “untitled-related-links-list”. Change the word “untitled” to a relevant name (for example “admissions-related-links-list”). This is the file name.

3. If the Placement Folder is not files/blocks, then click in the Placement Folder box and select the files/blocks folder and click Choose.

4. In the Related Links section:
   a. If you want to include an html page that is on your site, then under Related Page click the Choose Page box, select your page and click “Choose”.
   b. If you want to add an external link for a page that is not on your site, then under Related External Link, click in the “Choose Link” box, select your external link and click “Choose”.

5. Click the Advanced Submit button (three vertical dots at top right) and click Submit.

Note: The Related Links List Block will always appear on the live site with a “Related Links” heading.

Adding or changing a Right Callout Block

The Right Callout Block offers a similar function as the related links list. It will appear on every page you add it, and when you edit the block, it will publish to all pages (where it has been added). The major difference is that the Right Callout Block allows more customization of content. Instead of a links list, you will be able to add and edit content in an editing window.
WYSIWYG (What you see is what you get) Editor

Every content section (Columns, accordions, tabs, right callout section), can be edited using the WYSIWYG editor. For further information, as well as best practices, please visit the [Web Style Guide](#).

The WYSIWYG editor has a content area and a tool bar across the top with various tools:
Format

The **Format** menu contains familiar text styling options found in most word processing software. Please do not underline words or phrases, and only use the other options sparingly. The Formats secondary menu contains the same options as the Formats dropdown in the toolbar.

In this menu, you will see:

- Headings
- Inline
- Blocks
- And Custom

Please note that Blocks are not the same as the asset type “Blocks” (which are the Top Navigation, Right Callout block, and Related Links List block).

**Headings**

Headings are defined with the `<h2>` to `<h6>` tags where `<h2>` defines the most important heading and `<h6>` defines the least important heading.

Search engines use headings to index the structure and content of your web pages. Headers visually show the user the content structure. Similarly, assistive technologies like screen readers use headers as a table of contents allowing visitors to quickly navigate page content. To this end, **do not** use headings solely for visual styling such as making text a larger font.

**Blocks**

The main Blocks you will use in the content areas are Blockquote and Paragraph. Div and Pre are advanced options that affect the code behind the text. Please reach out to the Web team for questions involving those options.

*All body text used on your website should be marked as a paragraph.*
To add a Blockquote, highlight the needed text and choose Blockquote:

This is how a blockquote will appear on the live site, slightly indented with a light gray bar to the left:

```
Blockquote
```

**Custom**

The last option under the Format dropdown menu is **Custom**. This is the tool used for buttons, content-subhead styling, lead-paragraph styling and colored text.

Lead-paragraph styling is a larger, serif font (see below) that complements our regular font. They can be used at the top of the page to engage the reader. It also helps separate and emphasize content, especially on mobile. This styling type should be used sparingly.

The content-subhead option (see below) can be used as a section header, or to separate content. Similar to Blockquote text, lead-paragraph and content-subhead can be implemented by highlighting the required text, navigating to the Format dropdown, and choosing them.
Buttons

Buttons act as a call to action for site visitors. We recommend keeping the text short and in all caps.

To insert a button, highlight the text copy you want to make a button and go to the Formats menu. Under custom, select the type of button you would like to use. To insert the link, highlight the text and choose the link button on the toolbar. Note: Sometimes buttons need adjusted in the html to display properly. If you need assistance, please contact the Web team.

Colored Text

You may choose from a range of text colors as appropriate for the page. Please use colors sparingly, and note that colored text is generally harder to read. Links will be automatically marked and do not need extra colors applied.

Insert

Under Insert, you will find elements that you can add to the content area, many of which are also duplicated in the toolbar.

Anchor

By including an anchor tag within a page, you can place links on your page which, when clicked, allow the reader to jump to another location on the page.

First, click the cursor at the appropriate spot on the page you would like to link to. Then, create the anchor using the Insert > Anchor option, or clicking in the toolbar. A window will pop up:

```
Name the anchor something appropriate for the place in the page where you are linking. For instance, if there is a section halfway down your page about admission requirements, you may name the anchor something like “requirements”.

Please note that you can also include the anchor in the URL of the web page. It will look something like “www.umsl.edu/index.html#anchor”
```
Anytime you want to link to this specific section on the page, insert a link to the page containing the anchor, and make sure to fill in the Anchor field with the title of the anchor you made.

![Insert link dialog box](image)

**Media**

You may add media such as an embedded Youtube video by accessing Insert > Media, or clicking 📹 on the toolbar.

First, visit the Youtube video and right click on it. Then choose “Copy embed code”:

![Copy embed code dialog box](image)

Paste the embed code under in the field under the Embed tab after accessing the Media tool.
The General tab will auto-fill, and you can edit the values in the Dimensions boxes to set the desired height and width of your embedded video.

More information about the editing tools and best practices for using them are in the [Web Style Guide](#).
Full Width Content

Full Width Content allows you to add content areas that span the entire width of the page, useful for the space underneath a left navigation or right callout.

In this example from UMSL’s Bridge Program, the full width content starts after the left navigation. Usually, this space would not be accessible, but utilizing the full width tools will enable its use.

To access the full width content areas, scroll down to the bottom of a page you are editing. Checking Yes on the first option will give you a single column full width content area.

The second option, Add Below Content, will give you the option to choose template elements (Content with 1 Column, 2 columns, accordions, slideshow, etc.)
You may add further content areas as needed. One difference to note is that this section allows a 4 Column content area, as well as the ability to add background colors and images. If you are interested in incorporating color backgrounds or background images in this section, please contact the Web team and we will help explore the options.

Images

Photos added into content areas (Columns, Tabs, Accordions, and Right Callout blocks) of the page should be edited to the size needed prior to uploading into Cascade. The image editor can then be used to set parameters based on percent, and not pixels. *Please note that images in the Right Callout block or section of the page are not to exceed 180px width.*

1. Place your cursor where you want to insert the image. Remember to size the image appropriately before uploading. Image sizes should not exceed 250kb if possible. Please contact the Web team if you need help downsizing your images.
2. Click on the Insert/edit image tool.
3. Select *Internal*.
   a. Click in the *Image* box.
   b. A chooser window will open. Select a file using the Recent, Browse, or Upload links and then click “Choose”. Use the Upload link when the image file you want to use is on your computer and not yet part of your site directory. Then click *Choose*. 
c. Enter an **Image description**. This is the text that is used by screen reader software. The text is usually a short description of the image.

d. Dimensions can be set via pixel width or percentage. To ensure compatibility across all devices, use dimensions based on percentages. If you’d like to image to nearly fill the entire width of the content section, enter “90%” in the width (first) box, and leave the second box blank. Then check the “Constrain Proportions” box which will ensure the image maintains proper aspect ratio (the width and height remain consistent relative to each other).

4. Click “OK”

**Image Size Recommendations**

**Banner Photos**

Start with 1250px width by 375px height. For site visitors, the bottom edge of the image will be cropped differently by various screen sizes.

![Banner Photo Example](image.png)

Depending on how many columns are in your content section, the best image size will vary.

- **Group shot** - a medium image should be about 600px width by 400px height. A larger image can work, depending on how much space your site has. Please let us know if you have questions about an especially large image or if you notice an image distorting on mobile devices.

- **Headshot** - Size can vary but works best in a 2:3 aspect ratio. For smaller images, use 100px width by 150px height. For larger headshots, scale up as needed (200x300, 300x450).

- **Square images** - An image with a 1:1 aspect ratio. Depending on length of accompanying text, a good place to start with square images is 300px width by 300px height.

*Note: If your images appear stretched, squished, sideways on your page, please reach out to the web team for assistance. Having properly sized images is vital to the user experience.*

**Slideshow Images**

All slideshow images should be the same height and width for consistency as the user clicks through the slideshow. A landscape orientation is recommended. A good starting size for slideshows is 500px width by 300px height.
Note: If your site has no left navigation, the page will be wider, and thus a wider slideshow image size may work better. Try 800px width by 400px height to start with. If you’d like a tutorial on image sizing, please contact the web team.

Links

There are two types of links, internal and external. Internal links are links to pages or files within your Cascade site. External links are to pages outside of your site. To add or edit a link in a content area (1, 2, and 3 column content areas, tabs, accordions, etc):

1. Highlight the text you want to make a link, and then click on the insert/edit link tool.
   a. Select Internal if you are pointing to a page or file within your folders (your site).
      i. Click in the Link box.
      ii. A chooser window will open. Select a file using the Recent, Browse, or Upload links and then click Choose. Use the Upload link when the file you want to use is on your computer and not yet part of your site directory. Then click Choose.
   b. Select External if the link is not directly to a file on your site.
      i. A Link box appears. Type (or copy/paste) the full URL for the external link (e.g., https://www.umsl.edu).

2. Click Ok.

Adding an External Link

Some content types in Cascade require an external link to be added individually. Adding an external link to Cascade allows you to use the link in the Related Links List block, in the left or top navigation menu, slideshows, and content cards.
1. In the file directory, click on the files folder, then click on the arrow to the right of the external-links folder.

![Folder View](image)

2. Select Add Content > Default > External Link.

3. Complete the following:
   a. **Link Name** – The name you give your link is what will appear on the webpage.
   b. **Placement Folder** – This is the folder where the external link will be stored. If you clicked the “View Folder” arrow next to the folder’s name (“external-links”, Cascade will automatically use that folder as the placement folder).

   If you plan to use the link in a Related Links list, then best practice is to store the file in the files/external-links folder. If you want the link as a left menu option, then choose the folder under which you want this link to be a second level menu option or choose the root/site folder if you want this link to be a first level menu option.
   c. **Link** – Enter the full URL of the external webpage. You can copy/paste the URL from a website.
   d. **Metadata Set** – leave this set to default.
   e. Click the **Save & Preview** button.
   f. Click the **Submit** button.
Site-nav

Every site within Cascade has an asset named “site-nav”. It allows you to customize certain elements in the footer.

You will find this listed in your site’s base folder within Cascade:

![site-nav](image)

Click and edit as you would a normal page. The following fields are customizable: Office Name, Map Coordinates, Address, Address Line 2, Office Number, Secondary Header and Secondary Number.

![College Address and Numbers](image)

The fields will appear at the bottom of your site in the footer:

![Footer Content](image)
Map Coordinates

The map coordinates allow users to click the address and access directions from Google Maps. The easiest way to do this is simply to Google the desired location, click it within Google Maps, and then copy the URL from the page into the CMS:

Unpublishing and Deleting Files

Unpublishing a page will remove it from the live website. **Pages should always be unpublished before you delete a page or before you rename a page.** If you do not unpublish the asset first, the page will still be live even if the file itself was deleted. There may also be occasions when you want to unpublish a page from the website but keep it in Cascade so that you can have it for reference in the future.

Unpublish a file or page

1. Select the page or folder that you want to unpublish.
2. Right-click on the folder or file and select **unpublish** from the drop-down menu.
3. In the Unpublish page box click **Submit**.

Delete a file, page or folder

Deleting a file removes it from the Cascade server. You must first unpublish the file (or select to unpublish the file as part of the delete function) in order to remove the file from the cloud server and your live website.

1. Select the file or folder that you want to delete.
2. Right-click on the file or folder and select **Delete** from the drop-down menu.
3. BE SURE THE **UNPUBLISH CONTENT** box is checked.
4. Click Delete.
Restoring a Previous Version of the Page

Each time you submit a page that you are editing, a version of that page is saved. Past versions can be reviewed and restored.

1. Select the page in the file directory for which you want to restore a previous version.
2. Right-click on the page and select Versions from the drop-down menu.
   a. Or click a page to view it. To restore this version or to select to view additional versions, click More (at top right) and select the appropriate action.
Reordering Navigation and Subfolder Navigation

You can change the order in which your left-hand menu options appear on your website. To reorder the main level left-hand navigation:

1. Click the “>” symbol to the right of the main folder (or the appropriate subfolder) at the top of the file directory. You will see your folders and files listed in the main view area.

2. Sort by Order number by clicking the column name “Order”. Some folders, such as the “_internal”, and “files” folders do not display in the left navigation, so their position numbers are not relevant to the ordering. The item with lowest relevant number appears highest in the menu choices.

3. Use the reorder Drag a folder to place it in a higher or lower menu spot.

4. Publish. You must publish your entire site if you modify the left menu’s navigation order.

Restore Deleted Files

Deleted files are stored in the Trash for 30 days. The Trash can be accessed from your site and the link is located above your file directory. You can restore a file to your site while it is still in the trash.

1. Click on Trash.
2. Place a check mark next to the file(s) you want to restore.
3. Click the restore icon to restore the file(s). The files will be restored to the folder specified in the Original Location column.
Draft Versions

When you edit a file, Cascade creates a draft version. When you “Preview Draft” after editing a page, and before clicking “Submit”, you will have a draft version. If you have previously submitted the file, then you will have two versions, the current version and a draft. When you submit the “draft”, it will overwrite the “current” version.

From the My Content area of the Dashboard, you can see all the files for which you have a draft version.
Top Navigation

Sites may also take advantage of the top navigation feature in place of or in addition to the left-navigation.

The Web team will help implement this on your site if you wish to use this feature.

Editing the Top Navigation

Once the Web team has implemented the initial Top Navigation, you may edit it by accessing the appropriate block and making changes.

1. To add any links to the top navigation, you will need to add external link first.
2. Choose a name for the navigation link. The example shown below is for the first navigation item in the picture, “Marketing.”
3. If you’d like to add a navigation item without dropdown menu items underneath, choose “Add a Link,” and the navigation item will link directly to a page.
4. If you would like to add dropdown choices beneath the navigation item, choose No under “Add a Link.”
5. You will be prompted to enter dropdown item titles and links.

Please note that the Top Navigation must have between 4 and 7 menu items. Please try to keep dropdown menu items to 10 or less per category.
Metadata

Metadata is used to summarize information about a particular website. Search engines like Google scrape for metadata that is relevant to the website in order to rank the page in the search results listings. The more relevant and useful the metadata is, the higher a particular page will rank in the search results.

**Summary:** The summary is a brief synopsis about the webpage. It should include the most relevant information that describes what the webpage is about.

**Teaser:** The teaser is a short enticing phrase about the webpage. This content is displayed under the main title when searching for an item in Google search or similar search engines. Note: Search engines like Google have algorithms that may change what is displayed under the main title regardless of what is put into the Teaser section of the metadata, but best practices maintain that a Teaser section should be included in order to achieve a higher ranking in the search results listings.

**Description:** The description is the short description of the webpage. This should be a brief summary about the webpage and what information it provides.

**Keywords:** The keyword section should include words or phrases about the webpage. The keywords section is no longer of primary importance for search engine rankings. It is important that words most relevant to what a user would need or be searching for appear in the body content, titles, and headers of the web page itself.

**Start Date, End Date, Review Date:** You may set dates for the page to automatically publish, unpublish, or notify you for review. The page will move to **Expiration Folder** when the date has passed.
Calendar Widget

The calendar widget can be utilized to display public events on your webpage. First, you will need to create a widget, then embed the widget code into the source code of the desired webpage. The following is a guide on where the widget tool is located and how to use it to display events on your webpage.

1. You can find the widget tool on the calendar site at: https://calendar.umsl.edu/help/widget

2. You will need to log in to the events calendar. *Note: If you need to create a calendar account, you may sign in using your SSO at https://calendar.umsl.edu/.

3. To create a widget, the following fields will need to be filled in accordingly.
   a. The “Number of Results” field is the number of events that will be populated in the series of events that will be listed on the webpage. Up to 5 events will be displayed on the webpage. Increasing the number of results will continue to populate the events on the page. As one event date passes, a new, upcoming event will automatically be populated. Setting this field to 50 will ensure upcoming events are continuously being populated on your webpage.
   b. The “Days Ahead” field determines how far in advance an event will be populated in the list before it occurs; it will display events occurring within the (x) number of days. If you'd like the widget to display events occurring in the next six months for instance, enter 180 days.
   c. Then select a “Group” or “Department” for which related events you would like to have displayed on your webpage. (Ex: Selecting the Group “Career Services” will populate the events list on your webpage with events relating to Career Services etc.)

4. Once these fields have been filled out accordingly, scroll to the bottom of the page. You will notice a red tab that reads “Generate Code”. Click “Generate Code” and the tool will automatically generate the widget source code. You will then need to copy the source code that has been generated and paste it into the source code on the webpage you would like the events to be displayed. See the screen shot below for how to access the source code on your Cascade webpage.
*Note: If you do not see this icon, contact a member of the Web team and we will embed the source code for you on your webpage.

5. Once the generated widget source code has been embedded into the Cascade webpage source code, you will need to publish the page. At this point, you should see the events populated on your page.

Contact Us

Please contact any member of the Web team at https://www.umsl.edu/marketing/web/index.html with further questions or suggestions.